Main Screen

The main screen is divided into 4 windows: the navigation pane, the view pane and the reading pane and the To-Do Bar. The reading pane is similar to what used to be called the preview pane. Each can be controlled by the View menu.

The Navigation Pane:

The navigation pane has section buttons on it: Mail, Calendar, Contacts, Tasks, Notes, Folder List and Shortcuts. If you do not see all of these buttons, you can resize the pane so that you can see them all by dragging the dark thin blue bar (with dots on it) that divides the screen and drag it up. You can also customize the navigation pane by using the Configure Buttons option on the lower right section of the pane.

You can click on the double-arrow buttons on the navigation pane to minimize the entire pane to a single bar or to just minimize a section of the navigation pane.

Double-arrow buttons used for minimizing.
**Tips & Tricks:**

- Drag & Drop messages to the calendar, contacts, tasks, notes, etc.
- Use the Find a Contact! box on the Standard Toolbar to quickly find a contact while you are in e-mail, calendar, etc. (displays as Search Address Books)
- To quickly send an e-mail to a contact(s), find the contact using the find contact white box, then drag the contact’s info to the Inbox.
- To recall or resend a message, open the message in your sent items folder and click on Actions-recall or resend this message.
- Right-click on any message to get a shortcut list of options.
- In the Preview Pane of the message, click on the attachment and drag and drop it into a folder on your computer such as My Documents.

The Mail section also has a Favorite Folders area. You can drag & drop any folder from the Mail Folders area into the Favorites area and it will be copied into your favorites. They will then be easier to find and use.

** To remove a folder from the Favorites Folders – remember to right-click on the folder and choose Remove from Favorite Folders otherwise if you delete the folder from the favorites area it will also delete it from the entire mailbox!

**The View Pane:**

The view pane displays the actual items (messages, appointments, contacts, etc.) On the top of the view pane is the Arranged by: feature that is explained below. If you would like to see the column headers (Subject, From, Received, etc.) then you just need to resize the view pane so that it is larger and the reading pane is smaller. Keep resizing it until you see the column headers appear.

**The Reading Pane:**

The reading pane allows you to view the messages without having to double-click and open the messages. The reading pane displays to the right of the screen by default but can be displayed on the bottom of the screen or turned off completely by going to View – Reading Pane…

You can also work with attachments, accept or decline meeting requests, and use voting buttons in the reading pane.

**Getting Help**

There are many ways to get help in using Outlook 2007 at Emory:

1. Use the Type a Question for Help (white box in top right corner)
2. Use the Help Task Pane (Help – Microsoft Office Outlook Help…)
3. Use Microsoft Online Help (Help – Microsoft Office Online)
4. Use all of the help options on your IT Emory web site (www.it.emory.edu – Healthcare Exchange – Training, Help, FAQ…)
5. Call 8-INFO (to be used only for Emory Healthcare employees during initial migration to Outlook) (once the migration has finished please call your regular help desk numbers: Emory Healthcare: 8-Help; Emory University 7-7777 or your local support provider)
6. Send your questions to: ehc-exchange@emory.edu (for Emory Healthcare employees during initial migration only).
Outlook 2007 User Guide

Outlook Buttons

<table>
<thead>
<tr>
<th>New</th>
<th>Print</th>
<th>Categories</th>
<th>Work Week</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Msg</td>
<td>Address Book</td>
<td>Show work week</td>
<td>Work Week</td>
</tr>
<tr>
<td>Move to Folder</td>
<td>New Appt</td>
<td>Month</td>
<td>Monthly View</td>
</tr>
<tr>
<td>Delete</td>
<td>Group Schedules</td>
<td>New Contact</td>
<td></td>
</tr>
<tr>
<td>Reply to Sender</td>
<td>Go to Today</td>
<td>New Task</td>
<td></td>
</tr>
<tr>
<td>Reply to All</td>
<td>Daily View</td>
<td>New Note</td>
<td></td>
</tr>
<tr>
<td>Forward</td>
<td>Week View</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Organizing Messages

Sorting, Viewing & Grouping Messages:

The view pane allows you to change the sorting order of the window and how it is viewed. You can easily sort your messages by clicking on the Arranged by… button and choosing your sorting order (or use the view menu) and you can change how you view your messages by using View - Arrange by - Current View… You can also ungroup your messages by clicking on the Arrange by…button and clicking on Show In Groups which will turn the grouping option off.

If you want to sort by clicking on a column then you must first show columns. You can do this by resizing the View Pane to be larger and the Reading Pane to be smaller. Keep resizing the View Pane until the columns appear and the Arranged by Date option disappears.

Creating Folders:

Keeping too many messages in your Inbox can lead to many frustrating moments. It is difficult to sort through and find the messages that you need in a hurry. The more organized approach is to create personal folders and move messages into the folders on a continual basis.

** We recommend that you create your personal folders under the main Mailbox instead of under the Inbox due to synchronization speed for mobile devices and web use.

To create a folder, right-click on the Mailbox and choose New Folder... You can also create a folder within folders. If you are used to Groupwise, then create a main folder called “Cabinet” and place all of your personal folders under the Cabinet!
Outlook 2007 User Guide

Moving Messages:

You can move messages by dragging & dropping them into the appropriate folder. Use the shortcut keys (Ctrl & Shift – see the side panel under Tips & Tricks) to select multiple messages and move them all at once. You can also move messages automatically by creating rules. You can create rules to automatically move, delete, and flag messages (etc.). To create a rule, select Tools-Rules and Alerts… New Rule…

Categorizing Messages:

Categories are a great way to organize your messages by subject matter or purpose. To categorize a message, click on the block button shown above for a particular message. (If nothing happens when you click on the block button – right-click on the block button and select Set Quick Click…)

Each message can be in as many categories as you would like. To put the message into multiple categories, right-click on the block button and choose another category. You can also create your own categories by right-clicking on the block button and selecting All Categories.

Once your messages are categorized, you can then sort the messages by category by using the Arrange by…option OR look under the Search Folders option in the Navigation Pane to see the Categorized Mail view.

Flags:

You can quickly flag messages for follow-up by clicking the flag icon next to the message. When you flag an item for follow-up, it automatically becomes a task and can be seen as a task in the To-Do Bar. If you click again on the flag icon, the follow-up is marked as complete. Several flag colors are available to help you categorize and find messages more easily. Right-click on the flag icon to see all color choices and options.

You can also add reminders to flags. This allows you to change the type of flag and the due date. If a due date is filled in a reminder window will then pop up to remind you about the due date on this message.

Using Color:

You can organize your messages by color coding them. You can apply different colors to different users. To color code your messages, click on Tools-Organize… and click on Using Colors.

Searching for Messages

There are various features that you can use to help you locate messages in a timely manner. Some have been mentioned above (sorting, viewing, grouping, and
categorizing) and some mentioned below (finding and using the search folders option).

**Searching Messages:**

Use the Search Inbox area to search for messages. Once you fill in the search criteria and press the Enter key or click on the magnifying glass, all of the messages that match the criteria will display in the view pane. Click on the Clear button X to clear your search and show all messages again.

You can also customize your search by clicking on the Options drop-down and choosing an option there.

If all of the Search options are not available to you then you may want to activate a feature called Instant Search. A file must be downloaded and installed first and Outlook restarted in order for this feature to work. To start the process, click on the double-arrow button on the Search box and select Instant Search.

Once Instant Search is installed, you can use the double-arrow button to see more option in searching. This feature will not only search your Outlook mail but can also search your desktop!

**Using Search Folders:**

You can use search folders to view messages by various options. Search folders are virtual folders in that they do not contain actual messages but provide a view to only those messages that meet the specified criteria.

To create a search folder:

1. In the Navigation pane, right-click Search Folders.
2. Choose New Search Folder to open the New Search Folder dialog box.
3. From the Select a Search Folder list, select a condition.
4. Click OK.

**The Ribbon**

Outlook 2007 has been redesigned and now uses the ribbon when creating new email, appointments & meetings, contacts, and tasks.
Calendar Tips & Tricks:

- Use Control+Click to select non-adjacent items.
- Use Shift+Click to select adjacent items.
- Use the Date Navigator in the Calendar to view multiple days of appointments. Use the Ctrl+Click option to select several days that are not next to each other.
- Use the Today button to jump to the current day’s appointments.
- Right-click on time intervals to display short-cuts.
- Right-click in appointment screen to display short-cuts.
- Dragging appointments to another day/time moves them.
- Control+dragging appointments to another day/time copies them.
- To turn the taskpad on (like it used to be in previous versions) click on View-To-Do Bar-Normal.
- Right-click on the Calendar and click Open in New Window. This will open the calendar in a separate window.

The Quick Access Toolbar:

The Quick Access Toolbar always shows at the top of the screen no matter what tab is selected below. This is where the most common commands can be found. The Save, Undo, Redo, Next and Previous buttons are already shown but it is highly recommended to add other more useful buttons to this toolbar by clicking on the drop-down arrow at the end of the toolbar and selecting all of those commands that you use often.

The Office Button:

Most of the commands that you used to find under the File menu are now located here. The Options setting is also located here which used to be Tools-Options. The Office button will always display on the screen no matter what tab is selected.

Ribbon Tabs:

Commands are now organized by their functionality. When creating a new mail message for instance, there are 4 ribbon tabs: Message, Insert, Options, and Format Text. Once you click on a tab, then the related buttons are organized in Groups. For example, when creating a new message, the Message tab in divided into 5 groups: Clipboard, Basic Text, Names, Include, Options, and Proofing. The name of the group is displayed on the bottom of the ribbon and may also have a small button showing with an arrow on it. Clicking on this button will bring up the old dialog boxes for those features or the appropriate task pane that previous versions had.

Contextual Tabs:

New tabs will appear on the ribbon based on what is being done at the moment and what type of object is selected. For instance, if a picture has been inserted and the picture is currently selected, then a new Format tab will appear with the words Picture Tools appearing above it. They are also appearing in red. This ribbon will contain all of the buttons used to format a picture. This ribbon will then disappear once the picture is no longer selected.

MiniBar:

The MiniBar is a small toolbar that contains the most commonly used options and appears when text is selected. It will only appear for a few seconds and appears dimly. It will appear brighter once the mouse moves over it or if you right-click on the text.

Sending Messages

There are many ways to create a message but the following list describes the easiest way:
Outlook 2007 User Guide

1. Click on the Mail section button on the Navigation Pane (if you are not already there)
2. Click on the New button
3. Either type in the e-mail addresses, using a semi-colon to separate addresses OR click on the To…button to select names from the address book (if you need to add BCC to the screen – click on the Options tab – click on Show BCC).
4. Click in the Subject area to type in a subject
5. Click in the message area to type in a message
6. (Optional) Click on the paperclip button to add an attachment if necessary.
7. (Optional) Click on the signatures button to insert signatures.
8. (Optional) Click on the red exclamation button to send it as high priority.
9. (Optional) Click on the Options tab to use voting buttons, request a delivery or read receipt, delay the delivery of the message, etc.
10. (Optional) Click on the Format Text tab to format any text.
11. Click on the Send button to send the message.

Saving Messages

If you do not have time to finish your message or you are not ready to complete the message, you can always save it and finish it later. When you save a message it is automatically saved in the Drafts folder. You would have to open it up from there to finish the message and then send it. To save a message, click on the Save button on the Quick Access toolbar and then close the message.

Setting Message Options

You can use the Options tab on the Ribbon in the Message window to change delivery options and/or add other features to an e-mail message before sending it.

• **Voting Buttons** – You can use voting buttons to insert Yes/No buttons (or others) into the mail message so that the recipient can just reply to the message by clicking on one of the buttons. You can use Approve;Reject OR Yes;No OR Yes;No;Maybe OR you can customize your own responses. Once the respondents reply by clicking on the buttons, the sender will receive special email’s responses back in their Inbox. Once the sender “processes” the first response, then the sender can get a complete list of who voted and how by opening up the original sent message and a Tracking tab will appear.

• **Request a Delivery Receipt** – You can turn on this option to track whether the recipients receive your message. The sender will get a message in their inbox stating that the message was delivered for each recipient. Once the sender “processes” the first returned receipt, then the sender can get a complete list of who received what and when by opening up the original sent message and a Tracking tab will appear.
Request a Delivery Receipt – You can turn on this option to track whether the recipients read your message. The sender will get a message in their inbox stating that the message was read and opened for each recipient. Once the sender "processes" the first returned receipt, then the sender can get a complete list of who read what and when by opening up the original sent message and a Tracking tab will appear.

More About Tracking Options

When the tracking options are enabled (as discussed in the previous topic) you automatically receive a notification in your inbox from the System Administrator when a message is delivered/read. When a message marked for delivery is delivered, the notification sent back displays a green arrow icon and the subject Delivered:. When a message marked for read notification, the message sent back displays a green check mark icon and the subject Read:.

When the tracking options have been enabled, the Tracking page appears in the message window for messages in the Sent Items folder. The Tracking page displays the delivery and receipt status of the message. When a recipient opens a message marked for read notification, a warning box opens telling the recipient that the sender is requesting a read receipt. The recipient can select Yes to send the receipt or No to cancel the receipt.

You can customize the way the Tracking Options is setup by going to Tools – Options – Preferences – E-mail Options…Tracking Options…

Recalling/Resending a Message

Outlook allows you to recall messages sent to Exchange users who have not read or moved the message yet. To recall/resend a message, open the sent message first from your Sent Items folder, then click on the Other Actions button on the Ribbon – Recall This Message OR Resend This Message.

Outlook sends you a notification informing you whether the message recall succeeds or fails. The notification appears in your inbox as a message with a subject Message Recall Success or Message Recall Failure. When you recall a message, a Tracking page is added to the original message in the Sent Items folder.

When you recall a message, the recipient receives a message with the subject Recall. If the recipient reads the recall notice before the reading the original message, the recalled message will be removed from the recipient’s inbox.
Replying or Forwarding Messages

There are various ways that you can use to reply to a message or forward a message to someone else.

- You can single click on the message and use the Reply, Reply to All, or Forward buttons on the top of the screen
- You can right-click on the message and use the Reply, Reply to All, or Forward options
- You can open the message and use the Reply, Reply to All, or Forward buttons on the Ribbon.

Creating Rules

You can create rules that help you to automate your e-mail system and to stay better organized.

To create a Rule:

1. Click on Tools – Rules and Alerts... (Emory is not using Alerts)
2. Create a rule by using a template or by starting from blank
3. If you are using a template, click on the links in the bottom half of the screen to setup the rule and then click Next until you see the finish button.
4. If you are starting from blank then just click Next and setup the rule using the next 3 screens.
5. Click Finish.
6. Choose to enable or disable the rule. Enabling it will turn it on immediately while disabling it will keep it for future use but not be activated.

Out of Office Assistant

The Out of Office Assistant can be turned on so that all incoming messages can be automatically replied to when you are out of the office. This can be enabled/disabled using the Outlook 2007 or Outlook Web Access (OWA).

To setup the Out of Office Assistant...

1. Click on Tools – Out of Office Assistant...
2. Select the I am currently Out of Office option
3. Click inside the text box and write the message that you want to send while you are away.
4. When you return to the office and start Outlook, a box will pop up asking if you want to turn off the Out of Office Assistant.

**Junk E-mail Filter**

The Junk E-mail Filter looks at your incoming messages and reviews the subject and body for indications that the message is junk mail. Any messages that it views as junk mail is automatically placed in the Junk E-mail folder. This filter is turned on by default and set to a protection level of low. You can change the protection level through Tools-Options-Junk E-mail.

You can also add E-mail addresses to the filter if the automatic filter did not catch it. To do this, right-click on the mail message and choose Junk E-mail. Three filter lists are available:

- **Safe Senders List** – E-mail addresses that you include in this list will not be identified as junk mail.
- **Safe Recipients List** – E-mail addresses that you send messages to will not be treated as junk mail. (i.e. distribution lists)
- **Block Senders List** – E-mail addresses that you include in this list will automatically be treated as junk mail regardless of content.

**Deleting Messages**

You can delete messages, appointments, contacts, tasks or notes by selecting the item(s) (use the control+click or shift+click to select multiple messages) and then press the Delete key on your keyboard, the Delete button, OR select Delete from the right-click menu. You may also want to just drag & drop them to your Deleted Items folder in the Navigation Pane.

Items are automatically emptied from your Deleted Items folder every 14 days. If necessary, you can get an item back that has been deleted but is still in the Deleted Items folder. The easiest way to “undelete” from the Deleted Items folder is to select the item(s) and just drag them back to the Inbox, Calendar, etc.

You can also “empty” your deleted items folder any time you wish by right-clicking on the Deleted Items folder and selecting “Empty Deleted Items folder”.

**Undeleting Messages**

Have you ever deleted mail from your Deleted Items folder and then wanted to retrieve it? In most cases, you can with Outlook 2007. You have up to 2 weeks to recover
deleted items. To recover deleted items:

1. In the Folder list, click Deleted Items.
2. On the Tools menu, click Recover Deleted Items.
3. Click the item you want to recover. To select multiple items, click the first item, and then hold down CTRL and click additional items.
4. Click the Recover Selected Items button.

The items will be returned to your Deleted Items folder and marked as recovered and then you can move them to other folders.

**Working with Attachments**

You can use Outlook to send or distribute files of any type. These attached files are indicated by the paperclip icon. The recipient can then use the attached file as desired.

**Attaching a File:**

You can attach a file to your e-mail by clicking on the paperclip icon in the message dialog box. Once you attach a file, the Attachment Options…button will appear on the screen. Click on this button to see available options for this attachment. (Emory users will only be attaching regular attachments.) You will see more attachment options if you attach a picture file. Outlook gives you the ability to send the pictures as a smaller size.

**Working with an attached file:**

If you receive an e-mail with an attachment there are several ways to work with the attachment. One way is to select the message and use the Reading Pane to see the attached file. You can then right-click on the attached file and see the attachment options to open, print, save as, etc.

If you open an attachment in Word 2007, you will notice that the default view is the Reading Layout View. This is for easier reading onscreen. The document text does not appear as printed, rather it is adjusted to fit the screen. However, you can select the Actual Page button to view the document as it would print. You can turn this default view off for Outlook attachments in Word by going to Tools – Options – General – disable Allow Starting in Reading Layout option.

**Calendar**

The calendar provides scheduling features in Outlook. You can create personal appointments and events, meetings, check other people’s schedules, and have access to other people’s calendars.
The taskpad is NOT on by default but can easily be turned on by clicking on View – Taskpad…

**Calendar Views**

You can decide how many days that you want to see on the calendar by choosing the buttons across the top of the screen: Day, Week (Show Work Week or Show Full Week) or Month.

**Displaying Previous or Next**

You can quickly display previous or next Days, Weeks, or Months by clicking on the arrow keys displayed below.

![September 2007 Date Navigator](image)

**Date Navigator**

The date navigator (the window pane in the top left (or right) corner that shows the months) can be used to customize the days that are displayed in the appointment screen.

- Click and hold on the month to see a list of other months
- Use the Control key to select days that are not in consecutive order
- Use the Shift key to select days that are in consecutive order
- Click to the left of any week to select the entire week
- Resize the window to show more months

**Creating Appointments**

There are many ways to create an appointment or a meeting:
You can quickly change an appointment into a meeting by clicking on the Invite Attendees button on the Ribbon. An appointment will have a To: on the screen awaiting the attendee’s names to be entered. You can also use the Scheduling Assistant button on the Ribbon to look at invitees schedules before you send out the meeting invitation.

If there are conflicts appearing in the schedule then you can select another meeting time that works for all attendee – these are displayed on the right hand side of the screen under Suggested Times.

**Editing Appointments**

How you edit the appointment is dependent on what you would like to do with the appointment. To change information about an appointment or meeting, double-click and make the changes. To simply change the time, you do not need to double-click, instead just click and drag the border around the appt. to shorten/lengthen the duration. To move or copy an appointment, you can copy and paste it into the new date or simply drag & drop it to the correct date.

**Color Coding/Categorizing Appointments**

You can organize your calendar items by assigning different colors to different events. This is done by right-clicking on an item and choosing categorize… or by clicking on the categorize button on the Ribbon in the appointment screen. You can customize your own categories by right-clicking on an appt. – Categories – All Categories.

**Sharing Calendars**

For you to see someone else’s calendar, they have to give you “permission” to do so. They would need to open their Outlook Calendar and click on Share My Calendar. This will display the permissions screen for their calendar. They would then click the new button and select the person that they want to give rights to. Then they would select which rights to give that person by putting a check mark in the desired options.

To see someone else’s calendar; once you have been given rights; you would open up your Outlook Calendar and click on Open a Shared Calendar…select the person’s name whose calendar you are trying to see and click OK. Both calendar wills display on the screen at once. Once you open up someone else’s calendar for the first time, you would not need to go thru the same steps to open it in the future since all previously viewed calendars will be listed in the navigation pane on the left of the screen. You can then control whose calendar and how many calendars to see by placing check marks on the desired calendars or taking the check mark off to stop displaying that calendar.
Using the Taskpad

If the taskpad does not appear on the calendar then you need to turn on the To-Do bar. This can be done by clicking on View – To-Do Bar – Normal…

You can add tasks to the taskpad by just clicking where it says “Type a new task”. Just type the task and press Enter. If you want to enter more information about that task then can double-click the task to open the task dialog box. The task dialog box allows you to enter due dates, status, priority, and % complete for the task. You can also categorize the task or “link” it to a contact.

A task will keep appearing on the calendar every new day until it is either completed or removed. To complete a task, click in the check box.

Contacts

The Global Address List (GAL) will contain all company wide employees and is available from the Address Book. The Contacts book will contain all of your personal addresses. You can get to your contacts book from your address book by just changing what book it is looking at (the drop down arrow).

Adding Contacts
You can add contacts by switching to your Contacts book and clicking on the New button. Fill out all of the information that you know and click on Save and Close. You can also add contacts by just dragging a mail message to the Contacts section button on the Navigation Pane. This will automatically create a contact.

**Categorizing Contacts**

You can organize your contacts by placing each contact into certain categories. This is done by right-clicking on a contact and choosing categorize…. You can customize your own categories by selecting All Categories. Once you have categorizing your contacts, you can then view your contacts by category by clicking on View-Current View-By Category. (If you want the screen to look like the contact view again then switch it back to View by Business Cards or Address Cards.)

**Flagging Contacts For Follow-up**

You can flag each contact for follow-up so that you can keep better track on what type of work still needs to be done on that account. This can be done by right-clicking on a contact and choosing Follow-up… Flagging an item for Follow-Up in Outlook 2007 automatically makes it appear as a task on the To-Do Bar to remind you that you still need to follow up on it.

**Sending Contacts E-mail**

If you are in your Inbox already, then the easiest way to send e-mail to your contact(s) is to choose their names from your address book (remember to switch what book you are looking at to the contacts book). If you are in your contacts book, then the easiest way to send e-mail to your contact(s) is to drag and drop their address card into the Mail section button on the Navigation Pane.

**Distribution Lists**

Whenever you need to continuously send E-mail to the same group of people, then you should create a distribution list for this group of people and just send it to the list. To create a distribution list:

1. Click on File-New-Distribution List… (or click on the drop-down arrow next to the New button and select Distribution List…)
2. Type the name of your Distribution List.
3. To add members from your address book (or contacts), click on Select Members…
4. To add members that are not in any book, click on Add Members…
5. Click Save and Close

At Emory, there is a limitation of 100 members in any 1 address book. Once a distribution list is created, it will appear in your contacts book.
Outlook offers different options to print your contact list. Select File-Print…and choose a print style. You can also change the view and print that. (i.e. View-Current View-Phone List.)

**Forwarding Contacts**

Send contacts to other people by right-clicking on the contact you want to send and then click Forward. A new e-mail message will be created with that contact included as an attachment. When the recipients receive the contact, all they have to do is to drag the attachment onto the Contacts folder and it will be added automatically to their contacts list.

**Creating additional Personal Books**

You can create additional personal books by just right-clicking on the contacts folder in the navigation pane and selecting New Folder…

**Desktop Alerts**

A Desktop Alert is a semi-transparent message box that appears in front of the current window when a new e-mail message, meeting request, or task request arrives. The desktop alert displays who the item is from and the subject. By default, desktop alerts are turned on and only display for 7 seconds. When a desktop alert appears, pointing to it makes it more visible and leaves it on the screen for easier reading. Desktop alerts settings can be changed by clicking on Tools – Options – Preferences – E-Mail Options – Advanced E-Mail Options…Desktop Alert Settings…

**Creating a Signature**

You can create a signature so that it automatically appears on the bottom of all outgoing messages. To create a signature, click on Tools – Options – Mail Format – Signatures…New…type in a name for this signature, choose how to create your signature, click Next, and type in your desired signature. Click Finish and OK when done. The last signature that you create will be set as the default signature as shown under Signature for new messages:

If you don’t want to default to any signature (you would rather insert the signature manually when needed) then change the Signature for new messages: to None. To manually insert the signature you can use the Insert Signature button on the Insert tab when creating a message and select the signature to insert.
Using Outlook Today

You can set up the Outlook Today page to be the first page that you see when you open up Outlook. The Outlook Today page displays your appointment, tasks, and e-mail today. To view the Outlook Today page, click on the Mail button and click where it says Mailbox – Your Name in the Navigation Pane.

To customize the Outlook Today page, click on the Customize Outlook Today button in the upper right of the screen. You will see options to go directly to Outlook Today when starting, Message options, Calendar options, Task options, and styles.

To get out of the Outlook Today page, just click on another option (i.e. Inbox).

Outlook Options

You can easily set up Outlook to work better for you by going in to Tools – Options… and investigate all of the options available. Below is a list of some of the options that may help you:

- Preferences tab – Junk E-mail… – setup how Outlook handles junk e-mail.
- Preferences tab – E-mail Options… – setup e-mail, advanced e-mail options (including Desktop Alerts), and Tracking Options.
- Preferences tab – Calendar Options… – setup calendar and how it works for you including what days and hours you work.
- Preferences tab – Task Options… – setup tasks and how it works for you.
- Preferences tab – Contact Options… – setup contacts and how it works for you.
- Preferences tab – Note Options… – setup notes and how it works for you.
- Mail Format tab – setup Word 2007 as your e-mail editor, create signatures, etc.
- Spelling tab – setup spell checker to automatically check before sending a message, etc.
- Other tab – setup Navigation Pane Options, Reading Pane Options, etc.
- Delegates tab – setup someone else to send items on your behalf.
Outlook 2007 User Guide

Outlook Web Access (OWA)

If you need to check your Emory e-mail account and you are not at your work computer, then you can just log in to the web version called Outlook Web Access (OWA) from any computer.

You can get to the OWA web page by typing in the following web address into the address bar of your Browser:

https://ehcowa.emory.edu (for Emory Healthcare users)
https://owa.emory.edu (for Emory University users)

Once you do get to the correct web page you will see the following screen (or something similar!).

Public or shared computer should always be selected since you are using someone else’s computer. Only if you are at your Emory business computer would you change the selection to private computer. Outlook Web Access Light would only need to be selected if you are using another browser such as Mozilla or Netscape Navigator.

Your user name and password are the same as the client (desktop) version that you use on your business computer. Click Log On to get in.
Outlook 2007 User Guide

OWA Main Screen

OWA Buttons

<table>
<thead>
<tr>
<th></th>
<th>New Message</th>
<th>Search</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Show/Hide Reading Pane</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td>Single/Multiple Line</td>
<td>New</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>New</td>
</tr>
<tr>
<td></td>
<td>Check Messages</td>
<td>Today</td>
</tr>
<tr>
<td></td>
<td>Reply</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Reply to All</td>
<td>Work Week</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Week</td>
</tr>
</tbody>
</table>
As you can see, many features are similar between Outlook 2007 (the client or desktop version) and Outlook Web Access (OWA).

The following is a list of differences in the web version compared to the client version:

- There are no outlook menu’s available (the menu’s you see are Explorer menu’s) so you will have to use the Options button in the upper right corner to get to a lot of different options:
  - Signatures
  - Spelling
  - Calendar Options
  - Out of Office Assistant
  - Rules
  - Junk E-mail
  - General Settings
  - Deleted Items
  - Mobile Devices

- The Navigation Pane looks & acts slightly different
- You cannot create/edit distribution lists in the web version but you can view/use already created distribution lists

The following is a list of things you CAN do in OWA:

- You can drag & drop messages
- You can right-click on messages
- You can flag messages for follow-up
- You can set up Out of Office Assistant
- You can create folders
- You can create appointments & meetings

Logging Off OWA

When you are ready to close OWA you MUST Log Off before closing the Explorer window in order to keep your e-mail’s safe and secure. The Log Off button is in the upper right corner of the screen.
## Outlook 2007 Keyboard Shortcuts

### Inbox and Messaging Shortcuts

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+I</td>
<td>Switch to Inbox.</td>
</tr>
<tr>
<td>Ctrl+Shift+O</td>
<td>Switch to Outbox.</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Display message properties</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Mark All</td>
</tr>
<tr>
<td>Ctrl+Shift-B</td>
<td>Open Address Book</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected text</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Delete selected message</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Opens People Search Dialog</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Forward to selected message</td>
</tr>
<tr>
<td>Ctrl+Shift+F</td>
<td>Open Message Search Dialog</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Follow-up to newsgroups</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create new message</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print selected messages</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Reply to the author of selected message</td>
</tr>
<tr>
<td>Ctrl+Shift+R</td>
<td>Reply to author and all recipients of selected message.</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Display next unread message</td>
</tr>
<tr>
<td>Ctrl+&lt;</td>
<td>Display previous message</td>
</tr>
<tr>
<td>Ctrl+&gt;</td>
<td>Display next message</td>
</tr>
<tr>
<td>Ctrl+F2</td>
<td>Open message body in Notepad</td>
</tr>
<tr>
<td>Ctrl+F3</td>
<td>Display message source code</td>
</tr>
<tr>
<td>Esc</td>
<td>Close window</td>
</tr>
</tbody>
</table>

### Calendar Shortcuts

<table>
<thead>
<tr>
<th>Press</th>
<th>To create or open this item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+A</td>
<td>Appointment</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Contact</td>
</tr>
<tr>
<td>Ctrl+Shift+E</td>
<td>Folder</td>
</tr>
<tr>
<td>Ctrl+Shift+J</td>
<td>Journal entry</td>
</tr>
<tr>
<td>Ctrl+Shift+L</td>
<td>Distribution list</td>
</tr>
<tr>
<td>Ctrl+Shift+M</td>
<td>Message</td>
</tr>
<tr>
<td>Ctrl+Shift+Q</td>
<td>Meeting request</td>
</tr>
<tr>
<td>Ctrl+Shift+N</td>
<td>Note</td>
</tr>
<tr>
<td>Ctrl+Shift+K</td>
<td>Task</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Post in this folder</td>
</tr>
<tr>
<td>Ctrl+Shift+U</td>
<td>Task request</td>
</tr>
</tbody>
</table>

### Press to create or open this item

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+# (1-9)</td>
<td>View from 1 through 9 days</td>
</tr>
<tr>
<td>Alt+0 (Zero)</td>
<td>View 10 days</td>
</tr>
<tr>
<td>Alt-Hyphen Sign</td>
<td>Switch to weeks</td>
</tr>
<tr>
<td>Alt+Equal Sign</td>
<td>Switch to months</td>
</tr>
<tr>
<td>Ctrl+Tab Or F6</td>
<td>Move between Calendar, TaskPad, and the Folder List</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Select the previous appointment</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Go to the previous day</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Go to the next day</td>
</tr>
<tr>
<td>Alt+Left Arrow</td>
<td>Move selected item to the previous day when multiple days appear</td>
</tr>
<tr>
<td>Alt+Right Arrow</td>
<td>Move selected item to the next day when multiple days appear</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Go to the same day in the next week</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Go to the same day in the previous week</td>
</tr>
<tr>
<td><strong>For Day view</strong></td>
<td></td>
</tr>
<tr>
<td>Home</td>
<td>Select the time that begins your work day</td>
</tr>
<tr>
<td>End</td>
<td>Select the time that ends your work day</td>
</tr>
<tr>
<td>Up Arrow</td>
<td>Select the previous block of time</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Select the next block of time</td>
</tr>
<tr>
<td>Page Up</td>
<td>Select the block of time at the top of the screen</td>
</tr>
<tr>
<td>Page Down</td>
<td>Select the block of time at the bottom of the screen</td>
</tr>
<tr>
<td>Shift+Up Arrow Or Down Arrow</td>
<td>Extend or reduce the selected time</td>
</tr>
<tr>
<td>With The Cursor In The Appointment, Alt+Up Arrow Or Down Arrow</td>
<td>Move an appointment</td>
</tr>
<tr>
<td>With The Cursor In The Appointment, Alt+Shift+Up Arrow Or Down Arrow</td>
<td>Change an appointment start or end time</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Move selected item to the same day in the next week</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Move selected item to the same day in the previous week</td>
</tr>
<tr>
<td><strong>For Week or Month views</strong></td>
<td></td>
</tr>
<tr>
<td>Home</td>
<td>Go to the first day of the week</td>
</tr>
<tr>
<td>End</td>
<td>Go to the last day of the week</td>
</tr>
<tr>
<td>Page Up</td>
<td>Go to the same day of the week in the previous week (or 5 weeks previous if viewing by month)</td>
</tr>
<tr>
<td>Page Down</td>
<td>Go to the same day of the week in the next week (or 5 weeks ahead if viewing by month)</td>
</tr>
<tr>
<td>Alt+Up, Down, Left, Or Right Arrow</td>
<td>Move the appointment up, down, left, or right</td>
</tr>
<tr>
<td>Shift+Left, Right, Up, Or Down Arrow; Or Shift+Home Or End</td>
<td>Change the duration of the selected block of time</td>
</tr>
<tr>
<td><strong>For Date Navigator</strong></td>
<td></td>
</tr>
<tr>
<td>Alt+Home</td>
<td>Go to the first day of the current week</td>
</tr>
<tr>
<td>Alt+End</td>
<td>Go to the last day of the current week</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Go to the same day in the previous week</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Go to the same day in the next week</td>
</tr>
<tr>
<td>Alt+Page Up</td>
<td>Go to the first day of the month</td>
</tr>
<tr>
<td>Alt+Page Down</td>
<td>Go to the last day of the month</td>
</tr>
</tbody>
</table>